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1 . 1  I n s t a l a ç ã o .  

Blender. 

O Blender é um programa open source disponível para diversos sistemas operativos (Windows, Mac, Linux, etc.), que permite a geração 

de modelos tridimensionais e posterior texturização, renderização e animação, com uma qualidade similar aos produtos comercias 

(Maya, 3ds Max, etc.). Originalmente criado e distribuído comercialmente pela empresa holandesa Not a Number Tecnologies, é

actualmente desenvolvido pela Blender Foundation, sendo suportado por doações e vendas de materiais relativos ao Blender (livros, 

DVDs, etc.).  

O Blender é já hoje em dia utilizado por profissionais das muitas áreas em que é necessária a utilização de modelos 3D, arquitectura, 

design industrial, engenharia, animação, produção de vídeo, desenvolvimento de jogos, etc., permitindo a geração de imagens 

renderizas de qualidade fotográfica (Figura 1.1.1 e 1.1.2), animação: veja a curta metragem "Elephants Dream", (Elephants Dream @ 

Youtube, Elephants Dream @ Wiki), ou jogos 3D: veja o jogo de distribuição livre (código integral para diversos sistemas operativos) 

actualmente em desenvolvimento "Yo Fankie!". 

  

Figura 1.1.1  

 

Figura 1.1.2  

  



Faça o download da última versão do Blender a partir da página da Blender Foundation e instale-o no seu computador. 

Python. 

Como se disse, o Blender possui um motor de jogo integrado que permite a criação de aplicações interactivas 3D, tais como jogos e 

passeios virtuais. Embora não necessário nas aplicações mais simples, sempre que for necessária uma interface sofisticada com o 

utilizador, ou se pretender criar jogos com módulos lógicos mais complexos, é conveniente a utilização de scripts em Python, possuindo o 

Blender, para esse efeito, um editor incorporado.  

O Python é uma linguagem de programação de alto nível, interpretada (sendo possível a compilação para bytecode), orientada por 

objectos (sendo no entanto possível uma abordagem imperativa ou funcional), criada por Guido van Rossum em 1991, sendo

actualmente um produto de distribuição livre de desenvolvimento comunitário e aberto gerido pela organização sem fins lucrativos 

Python Software Foundation. 

Na sua criação foi dada ênfase à simplicidade e legibilidade do código, pelo que é de muito fácil aprendizagem. Simultaneamente, a sua

biblioteca padrão e os módulos e frameworks desenvolvidos por terceiros tornam-na num linguagem extremamente poderosa e eficiente, 

sendo hoje em dia a linguagem preferida de uma enorme comunidade de programadores.  

  

Faça o download da última versão do Python (bem como de um conjunto de módulos que virão a ser necessários) a partir 

daqui e instale-o no seu computador. 

  

  



1 . 2  J a n e l a s  i n i c i a i s .  

Ao abrir o Blender estão visíveis 3 janelas: a Janela de Preferências (User Preferences), figura 1.2.1; a Janela 3D (3D View), figura

1.2.2; e a Janela de Botões (Buttons Window), figura 1.2.3.

 

Figura 1.2.1 

 

Figura 1.2.2 

 

Figura 1.2.3 

Qualquer das janelas é redimensionável do modo habitual, deslocando o rato até ao 

bordo da janela (até que o cursor mude para dupla-seta), pressionando e segurando 

[LB ] e deslocando o rato.  

FullScreen. 

Pode passar qualquer das janelas ao modo fullscreen pressionando [Ctrl+�] (e sair 

do modo fullscreen pressionando [Ctrl+�]).  

Tipo de janela.  

Pode mudar o tipo de janela deslocando o rato até ao símbolo presente à esquerda da

barra da janela e seleccionando-o, [LB ]. No menu que surge no ecrã, figura 1.2.4, 

pode seleccionar qualquer dos 16 possíveis tipos de janela. Falaremos e cada um

deles à medida que forem considerados necessários. 

Posição da barra de menus. 

Se levar o rato até à barra de menus de qualquer das janela e pressionar [RB ] verá 

aparecer o menu da figura 1.2.5. Aí poderá seleccionar o posicionamento da barra 

relativamente à janela, ou a sua ocultação. 

  

 

Figura 1.2.4 

 

Figura 1.2.5 

  



1 . 3  C r i a ç ã o  d e  j a n e l a s .  

Podemos criar novas janelas subdividindo o espaço ocupado por uma delas. 

Partição vertical. 

Leve o cursor do rato até uma fronteira horizontal entre quaisquer duas janelas e

pressione [RB ]. Verá aparecer o menu da figura 1.3.1. Seleccione Split Area. Verá 

aparecer uma barra vertical cinzenta. Movendo o rato, desloque a barra para a direita 

ou para a esquerda e posicione-a no local onde deseja fazer a divisão. Pressione [LB 

]. A janela subdivide-se em duas (do mesmo tipo) lado a lado.  

Partição horizontal. 

Leve o rato até uma fronteira vertical entre quaisquer duas janelas e pressione [RB 

]. Verá aparecer o menu da figura 1.3.2 Seleccione Split Area. Verá aparecer uma 

barra horizontal cinzenta. Desloque a barra para cima ou para baixo e posicione-a no 

local onde deseja fazer a divisão. Pressione  [LB ]. A janela subdivide-se em duas 

(do mesmo tipo) uma sob a outra. 

Qualquer das janelas pode ser subdividida o número de vezes que desejar. Mantendo 

[Ctrl] pressionada e usando sucessivamente [�] (ou [�]) temos acesso a diversas

configurações predefinidas para a distribuição no ecrã dos vários tipos de janelas 

disponíveis no Blender. A figura 1.3.4 mostra umas das configurações possíveis. Note 

que ao seleccionar sucessivamente cada uma das configurações predefinidas um dos

menus da janela de preferências vai alterando a informação exposta (figura 1.3.3). 

Este menu pode ser utilizado para fazer a selecção de cada uma das configurações. Se

o desejar pode gravar uma qualquer distribuição de janelas (Janela de 

Preferências>File>Save Default Settings), depois de definida a configuração,

passando a ter uma nova opção no menu. 

 

Figura 1.3.1 

 

Figura 1.3.2 

  

Figura 1.3.3  

 

Figura 1.3.4 

Remoção de janelas  

Para remover uma das janelas leve o rato até uma das fronteiras da janela a remover, pressione [RB ], e seleccione Join Area. 

  

� Teste as acções de criação de janelas repetidas vezes para observar o seu efeito e se familiarizar com a sua 

utilização. 



1 . 4  M o d o s  d e  v i s u a l i z a ç ã o  3 D .  

Existem 6 modo de visualização dos objectos na janela 3D: 

1. frontal (Front); 

2. lateral direita (Side); 

3. topo (Top; 

4. visão da câmara (Camera); 

5. perspectiva (Perspective); 

6. e projecção ortográfica (Orthographic). 

Pode seleccionar o modo de visualização quer com o rato quer com teclado.  

   

Rato. 

Utilizando o rato seleccione (View) na barra da janela 3D. Aparecerá um menu como 

o que se mostra na figura 1.4.1. A partir deste pode seleccionar o tipo de visualização 

que deseja. 

Note que nesta janela, à direita de cada um dos modos de visualização, é indicado o 

modo como o mesmo pode ser seleccionado através do teclado numérico. 

   

Teclado. 

Accione o [NumLock]. As teclas que permitem modificar o modo de visualização são: 

Abordaremos noutra secção os restantes comandos acessíveis neste menu e nos 

submenus [Align View] e [View Navigation], que estão associados à navegação na

janela 3D (mudança do ponto de observação). 

  

  

[5]
 [5] (Ortogonal / Perspective) Alterna entre o modo perspectiva e 
projecção ortográfica.

[3] (Side) Visão lateral direita.

[1] (Front) Visão frontal. 

[7] (Top) Visão superior. 

[0] (Camera) Visão da câmara.

[/]
Alterna entre visão global e visão local (enquadramento do objecto 
seleccionado na janela).

[Home] (View All) Enquadra todos os objectos na janela.

[.] Enquadra o objecto seleccionado na janela (visão local definitiva). 

CTRL + � 

CTRL + �
Passa ao modo fullscreen e sai do modo fullscreen (a acção tem 
efeito sobre a janela onde o rato se encontra).

 

Figura 1.4.1 

 

 

 

� Teste cada uma das acções de modificação do modo de visualização repetidas vezes para observar o seu efeito e se 

familiarizar com a sua utilização. 



1 . 5  E x e r c í c i o  0 1 .  

Utilizando os conhecimentos que adquiriu até aqui configure o seu ambiente de trabalho no Blender como se mostra na figura 1.5.1.

Salve o ficheiro com o nome exercicio01#####.blend, fazendo corresponder os cardinais ao seu número de aluno. 

 

Figura 1.5.1 

Note que:  

1. A janela em cima à esquerda está em View-Side.  

2. A janela em cima à direita está em View-Front.  

3. A janela em baixo à esquerda está em View-Top.  

4. A janela em baixo à direita está em View-Camera.  

5. Para fazer o alinhamento vertical dos painéis na janela de 

botões coloque o rato sobre a janela e pressione [RB ]. No 

menu que surge, figura 1.5.2, seleccione (Vertical). 

  

 

Figura 1.5.2 



1 . 6  N a v e g a ç ã o  3 D .  

Vamos ver nesta secção como pode modificar o ponto de vista do utilizador sobre os objectos presentes nas janelas 3D (a sua posição de

observação da cena). 

Os comandos são independentes do modo de visualização (Top, Side, etc.). Se tiver uma janela 3D View-Camera os comandos não têm 

qualquer repercussão, dado que, nesta janela, a cena está a ser representada do ponto de vista da câmara  

Teclado. 

Accione [NumLock]. As teclas que permitam modificar o ponto de

observação são: 

   

  

Rato. 

As acções de translação, rotação e zoom pode ser feita utilizando o rato:

 

[Ctrl]+ [8] 
[Ctrl]+[2] 

 (Pan) Move a janela de observação segundo a direcção 
vertical do plano do ecrã.

[Ctrl]+ [4] 
[Ctrl]+[ 6] 

(Pan) Move a janela de observação segundo a direcção 
horizontal do plano do ecrã.

[8] 
[2]

(Rotação) Rotação da janela de observação em torno do 
eixo coordenado que mais próximo está da horizontal.

[4] 
[6]

(Rotação) Rotação da janela de observação em torno do 
eixo dos zz.

[+]/[-] 
(Zoom) Faz zoom in e zoom out na janela que estiver 
activa (seja ou não uma janela 3D)

 

Figura 1.1.4 

Os comandos de navegação 3D são acessíveis a partir da selecção, na barra das janelas 3D, do submenu [View/View Navigation]. 

  

 

Figura 1.3. 

[MB ] Movendo o rato, roda a janela de observação em torno de um eixo arbitrário.

[Shift]+[MB ] Movendo o rato, move a janela de observação sobre qualquer direcção no plano do ecrã.

[Shift]+[MW ] Move a janela de observação na vertical do plano do ecrã.

[Ctrl]+[MW ] Move a janela de observação na horizontal do plano do ecrã.

[MW ] Faz zoom in e zoom out.

� Teste cada uma das acções de navegação 3D repetidas vezes para observar o seu efeito e se familiarizar com a sua 

utilização. 

  

  



1 . 7  T r a n s l a ç ã o ,  r o t a ç ã o  e  e s c a l a m e n t o  d e  o b j e c t o s .  

Ao abrir o Blender, já existem alguns objectos na janela 3D: um cubo; uma luz; e uma câmara. 

O cubo encontra-se centrado no sistema de eixos coordenados em modo de visualização superior, ou seja, o plano reticulado que está a 

ver corresponde ao plano xy. 

Como pode observar, o cubo tem coloração rosa, figura 1.7.1. Isto significa 

que o cubo é o objecto seleccionado. 

Note que no canto inferior esquerdo é dada informação sobre o posicionamento 

dos eixos coordenados e do objecto seleccionado, figura 1.7.2. Referiremos

noutra secção o significado do número entre parêntesis. 

�    Para seleccionar um objecto pressione o botão direito do rato [RB

]. Se pressionar a tecla [Shift] simultaneamente poderá seleccionar mais do

que um objecto. 

Todo o objecto seleccionado poderá sofrer transformações de posicionamento,

forma, etc. Abordaremos por agora apenas as acções de translação, rotação e 

escalamento. 

Como abaixo se detalha, a interface do Blender permite-lhe fazer qualquer das 

3 transformações de diversos modos. Escolha a que melhor se adapta ao seu 

estilo de trabalho. 

[RB ]  Selecção de um objecto 

[Shift]+[RB ]  Selecção de vários objectos
 

Figura 1.7.1 

 

Figura 1.7.2 

Na barra da janela 3D seleccione (Object) e, no menu que aparece, seleccione (Transform), figura 1.7.3. A partir dos submenus que 

aparecem pode executar as acções de translação (Grab), rotação (Rotate) ou escalamento (Scale). Note que, à direita, estão indicadas 

as teclas que pode usar para proceder a cada uma das transformações através do teclado. 

 

Figura 1.7.3 



Pressione [Space] (barra de espaços). Verá surgir o menu que se mostra na

figura 1.7.4. Neste menu está acessível um conjunto de acções que encontra 

disponível em diversas zonas da interface do Blender. Por serem as de mais

frequente utilização, foram agrupadas neste menu de fácil acesso. 

Descreve-se abaixo como as acções de transformação podem ser executadas por

recurso ao teclado ou ao rato. 

As teclas a  ter em conta são a [G], a [R] e a [S] (as inicias das acções de Grab, 

Rotate e Scale).  

Teclado. 

A translação, rotação e escalamento de objectos utilizando o teclado é feito 

conforme se especifica na tabela abaixo (nota: o símbolo � significa “seguido 

de”) 

[G] � Cursor
Translação do objecto seleccionado segundo o 

cursor.

[G] � [Ctrl] + Cursor Translação em incrementos de unidade da malha.

[G] � [Shift] + Cursor Translação com ajuste fino

[R] � Cursor Rotação do objecto seleccionado.

[R] � [Ctrl] + Cursor Rotação com incrementos de 5º.

[R] � [Shift] + Cursor Rotação com ajuste fino.

[S] � Cursor Escalamento do objecto seleccionado.

[S] � [Ctrl] + Cursor Escalamento com incrementos de 0.1.

[S] � [Shift] + Cursor Escalamento com ajuste fino.

 

Figura 1.7.4 

 

 

Rato. 

A rotação e translação de objectos pode ser efectuado por utilização simultânea do teclado e do movimento do rato conforme se 

especifica na tabela abaixo. 

Tal como através do teclado, se o desejar, pode seleccionar uma das 3 direcções coordenadas, pressionando a respectiva tecla, [X, Y ou

Z]. 

Depois de fazer a alteração desejada, pressione o botão esquerdo do rato [LB ] .  

Os resultados da operação de escalamento podem parecer confusos. Todos os objectos em Blender têm um centro. Note o pequeno 

circulo assinalado a rosa (figura 1.7.8). A modificação do factor de escalamento depende apenas da modificação da distância do cursor 

do rato ao centro do objecto 

[RB ] + Rato 
[G] � Rato 

Translação livre do objecto seleccionado.

[G] � [Ctrl] + Rato Translação em incrementos de unidade da malha.

[G]  � [Shift] + Rato Translação livre com ajuste fino.

[R] � Rato Rotação do objecto seleccionado.

[R] � [Ctrl] + Rato Rotação com incrementos de 5º.

[R]  �  [Shift] + Rato Rotação com ajuste fino.

[S]  � Rato Escalamento do objecto seleccionado.

[S] � [Ctrl] + Rato Escalamento com incrementos de 0.1.

[S]  �  [Shift] + Rato Escalamento com ajuste fino

Note que enquanto efectua qualquer das 3 acções de transformação, na barra

inferior da janela 3D é indicada a variação das coordenadas do centro do 

objecto sobre o qual está a actuar, figura 1.7.5. 

Figura 1.7.5 

 



Janela de Transformações. 

A translação, rotação e escalamento de objectos pode também ser feita a

partir da janela que se mostra na figura 1.7.6, a que poderá aceder 

pressionando [N], normalmente utilizada quando se deseja fazer

transformações com grande precisão. 

Nesta janela, pode proceder a uma translação incrementando ou

decrementando as coordenadas da posição do centro do objecto pressionando 

os pequenos cursores que se encontram à direita e à esquerda das células

correspondentes a cada um dos eixos. 

Procedendo de modo idêntico pode fazer a rotação do objecto em torno de 

cada um dos eixos coordenados, ou fazer o seu escalamento. 

Pode digitar directamente o valor da translação, rotação, ou factor de 

escalamento que deseja efectuar, editando a célula conveniente. Para isso 

pressione [Shift]+[LB ] com o cursor do rato sobre a célula desejada . 

Pressionando o botão com a imagem do cadeado, à esquerda de cada célula, 

inibe qualquer futura acção correspondente à célula.  

  

  

 

Figura 1.7.6 

 

Figura 1.7.7 

Menu de transformadores 

Pode ainda proceder a uma translação, rotação ou um escalamento, acedendo, na barra da janela 3D, ao menu de transformadores, 

figura 1.7.7. Pressionando cada um dos símbolos (Triângulo: translação; Círculo: rotação; Quadrado: escalamento) fará surgir sobre o 

objecto seleccionado um conjunto de 3 linhas (eixo dos xx a vermelho; eixo dos yy a verde; e eixo dos zz a azul) , figura 1.7.8, que pode 

manipular, pressionando [LB ] sobre uma delas e movimentando o rato. Pode ainda ter acesso a todas as acções em simultâneo 

pressionando [Ctrl]+[Space] e seleccionando a opção Combo do menu que aparece. 

 

Figura 1.7.8 

� Teste cada uma das acções de modificação do posicionamento e escalamento de um objecto repetidas vezes para 

observar o seu efeito e se familiarizar com a sua utilização 

  

  



1 . 8  I n s e r ç ã o  d e  o b j e c t o s  e l e m e n t a r e s .  

Objectos elementares. 

O Blender tem 10 objectos elementares (Meshes), figura 1.8.1: 

• um plano; 

• um cubo;  

• um círculo; 

• uma esfera  tipo UVsphere; 

• uma esfera tipo IcoSphere; 

• um cilindro; 

• um cone; 

• uma grelha; 

• uma cabeça de macaco; 

• e um toróide; 

Inserção de objectos elementares. 

Para inserir um dos objectos elementares, da barra da Janela de Preferências, 

seleccione (Add), e do submenu apresentado seleccione (Mesh) e o objecto

pretendido, figura 1.8.2. Pode também ter acesso a este menu (entre outros) 

pressionando [Space]. 

Não se preocupe por enquanto com os parâmetros característicos de cada um dos 

objectos, seleccione simplesmente a opção (ok) do quadro que lhe é apresentado.  

O objecto (o seu centro) é inserido no ponto onde se encontra o cursor, representado

pelo pequeno círculo branco e vermelho, figura 1.8.1. 

Note que é completamente impossível perceber onde se encontra o curso no espaço

3D sem ter acesso às 3 vistas (Top, Side e Front). 

Quando um novo objecto é inserido o Blender atribui-lhe um nome padrão (ex: Cube,

Cube.001, etc.). É boa prática alterar esse nome para outro com maior significado na 

cena em desenvolvimento. Para alterar o nome de um objecto edite o campo OB nos

painéis da janela de botões em Modo Objecto [F7], figura 1.8.4, ou em Modo Edição 

[F9], figura 1.8.5. 

Modo  Objecto e Modo Edição. 

O Modo Objecto e o Modo Edição (Edit Mode) são os dois modos básicos de 

manipulação de objectos na janela 3D. 

Em Modo Objecto temos acesso ao objecto como um todo. É por isso o modo 

conveniente para fazer transformações globais do objecto, como seja uma translação, 

um escalamento, etc. 

Em Modo Edição temos acesso aos vértices da malha que constitui cada um dos 

objectos. É por isso o modo conveniente para fazer alterações pontuais à forma de 

cada objecto. 

�

Para mudar a posição do cursor, 

coloque-o no ponto desejado e 

pressione [LB ].

Para alinhar o cursor com os eixos 

coordenados pressione [Shift]+[S] e 

seleccione a opção (Cursor-Grid), 

figura 1.8.3. 

 

�
Para sair do Modo Edição e voltar ao Modo 

Objecto, e vice-versa, pressione a tecla [Tab].

 

Figura 1.8.1 

 

Figura 1.8.2 

 

Figura 1.8.3 

 

Figura 1.8.4 

 

Figura 1.8.5 



Note que se inserir sequencialmente dois objectos sem sair do modo edição, o 

segundo objecto é fundido no anterior formando um só objecto (o que, normalmente, 

não é desejável). 

  

Para mudar de modo, pode também seleccionar a opção disponível na barra da janela 

3D, figura 1.8.6. Falaremos dos diversos modos de trabalho nas janelas 3D à medida 

que a utilização de cada um deles se revelar necessário. 

  
 

Figura 1.8.6 

� Abra o ficheiro exercício#####.blend. Pense num ponto do espaço 3D, (x,y,z), e tente colocar o cursor nesse 

ponto, observando a sua movimentação em cada uma das 4 janelas. Repita o procedimento para diferentes pontos até 

se sentir seguro quanto ao seu posicionamento. 

� Teste a inserção de objectos elementares em pontos pré-determinados até se sentir familiarizado com a operação. 

  

  



1 . 9  E x e r c í c i o  0 2 .  

Abra o seu ficheiro exercício1#####.blend. 

Utilizando os conhecimentos que adquiriu até aqui insira: 

1. um cilindro no ponto [0.0 0.0 0.0]; 

2. um cone no ponto [2.0 0.0 0.0]; 

3. e uma esfera (UV) no ponto [-5.0 0.0 0.0], 

obtendo a cena que se mostra na figura 1.9.1. Salve o ficheiro com o nome exercicio2#####.blend. 

 

Figura 1.9.1 

  

  



1 . 1 0  M o d e l a ç ã o  1 .  

Comece por abrir o seu ficheiro exercicio1#####.blend. Só tendo acesso às 4 

vistas terá uma ideia clara daquilo que está a fazer no ambiente 3D. Já sabe que pode

fazer qualquer das janelas entrar e sair do modo fullscreen pressionando [CTRL+�]/ 

[CTRL+�] . 

Uma vez em Modo Edição, pode fazer alterações sobre cada um dos elementos da 

malha (Wireframe) dos objectos, seja um vértice, uma aresta ou uma face, 

alterando assim pontualmente a forma do objecto.  

  

Modos de representação. 

   

Na barra da janela 3D seleccione a opção (Modos de Representação), figura 1.10.1.

Como pode ver existem 5 alternativas, sendo Solid a representação padrão, figura 

1.10.2. Dependendo da complexidade do objecto, em modo edição poderá ser 

conveniente a representação Wireframe, figura 1.10.3. 

Selecção e transformação de vértices, arestas e faces. 

  

Entre em Modo Edição. Note que surgiu na barra da janela 3D o menu da figura 

1.10.4. Neste pode seleccionar que tipo de elemento da malha dos objectos deseja

editar: 

 vertices; 

 arestas; 

 ou faces. 

Tome cuidado. Ao entrar em Modo Edição todos os vértices do objecto seleccionado 

em Modo Objecto se encontram activos mas não o centro do objecto.  Se mover

(rodar, escalar) o objecto como um todo o seu centro não acompanha a 

transformação. 

Os elementos seleccionados têm coloração amarela e os não seleccionados têm 

coloração rosa, figura 1.10.5. 

Uma vez seleccionado pode transformar um elemento recorrendo ao conjunto de 

acções descritas na secção 1.7. a propósito da translação, rotação e escalamento de 

um objecto como um todo (teclas G, R, S, N, etc.). A figura 1.10.6 mostra um 

exemplo do menu activado pela tecla N, quando apenas um vértice foi seleccionado, 

sobre o qual podem ser inseridas, com grande precisão, as coordenadas do vértice. 

Para mover um elemento pode, por exemplo, executar a sequência: 

1. Pressionar [RB ] sobre o elemento. 

2. Arrastar o rato segurando [RB ]. 

3. Confirmar a acção pressionado [LB ]. 

�
Para entrar em Modo Edição (ou sair) pressione 

[Tab].

�
Pressionando  [Z] comuta entre os modos Solid 

e Wireframe. 

�
Para seleccionar ou desseleccionar todos os 

elementos  pressione [A]

�
Para seleccionar um elemento coloque sobre ele 

o cursor do rato e pressione [RB ].
 

� Para confirmar a transformação pressione [LB ].  

  

Figura 1.10.1  

Figura 1.10.2               Figura 1.10.3 

 

Figura 1.10.4 

 

Figura 1.10.5 

 

Figura 1.10.6 



Selecção múltipla. 

  

Para fazer selecção múltipla de elementos mantenha [Shift] pressionada e pressione 

[RB ] sobre cada um deles. 

São seleccionados assim todos os elementos que ficarem no interior do rectângulo que 

surge no ecrã, figura 1.10.7. 

Para desseleccionar um conjunto de elementos, proceda de igual modo mas mantendo 

agora [RB ] pressionando . 

Se pressionar [B] duas vezes a selecção múltipla é feita de modo idêntico, mas agora

numa região circular, figura 1.10.8. Controle o diâmetro da circunferência com [MW

]. Para sair da selecção circular pressione [Esc]. 

  

Remoção de elementos. 

  

Verá surgir no ecrã a tabela da figura 1.10.9, que lhe permite seleccionar o tipo de 

elementos a remover. 

�

Para seleccionar um número elevado de 

elementos pressione [B] e arraste o rato com 

[LB ] pressionado. 

�
Após ter seleccionado um ou mais elementos 

pode remove-los pressionando a tecla [X].

 

Figura 1.10.7 

 

Figura 1.10.8 

 

Figura 1.10.9 

� Teste repetidamente as acções de selecção e transformação dos elementos de uma malha para observar o seu 

efeito e se familiarizar com a sua utilização. 

  

  



1 . 1 1  E x e r c í c i o  0 3 .  

Abra o seu ficheiro exercício2#####.blend. 

Utilizando apenas os conhecimentos que adquiriu até aqui modele os objectos que se mostram nas figuras 1.11.1 a 1.11.4. 

Salve o ficheiro com o nome exercicio03#####.blend, fazendo corresponder os cardinais ao seu número de aluno. 

 

Figura 1.11.1 

Note que:  

1. As figuras 1.11.1 e 1.1.2 correspondem, 

respectivamente, às vistas lateral e frontal dos 

objectos.  

2. As figuras 1.11.3 e 1.1.4 correspondem a 

vistas de pormenor.  

3. O corpo da caneta e o invólucro de tinta são 

cilindros ocos. 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

 

Figura 1.11.2 

 

Figura 1.11.3 

Figura 1.11.4 



1 . 1 2  I l u m i n a ç ã o  1 .  

A planificação da iluminação de uma cena, conjuntamente com a definição das

características dos materiais dos objectos intervenientes, é extremamente

importante para o grau de realismo alcançado pela renderização, isto é, pelo 

processo de construção da imagem 2D correspondente à projecção do modelo

3D no plano de observação.  

Vamos por agora ver apenas os tipos de fontes de luz disponíveis, as suas 

características básicas, e como accionar as suas propriedades mais simples. 

Veremos todos os detalhes dos painéis de controle de cada uma das fontes de 

luz numa posterior abordagem do tema. 

Tipos de fontes de luz . 

O Blender tem 5 tipos de fontes de luz: 

1. Lamp : Simula uma fonte de luz pontual isotrópica (que radia 

igualmente em todas as direcções). Quanto maior for a distância 

de um objecto a uma fonte Lamp menor é a intensidade da luz 

que recebe, sendo a lei que determina a dependência da 

distância seleccionável a partir de modelos de decaimento com a 

distância pré-definidos, ou especificados pelo utilizador. A figura 

1.12.1 mostra um exemplo de objectos iluminados por uma 

fonte Lamp.  

2. Sun: Simula uma fonte de luz de área infinita a grande 

distância : raios paralelos e intensidade constante, ou seja, não 

dependente da distância à fonte. Portanto, não é importante a 

distância dos objectos a iluminar a que uma fonte Sun é 

colocada. Por outro lado, é muito importante o controle da sua 

direcção. A figura 1.12.2 mostra um exemplo de objectos 

iluminados por uma fonte Sun.  

3. Spot: Simula uma fonte de luz que emite um feixe de 

abertura cónica. Como se verá, é o único tipo de fonte que tem 

associado uma técnica de cálculo do efeito da luz na cena, 

chamada no Blender Buffered Shadows, que é bastante mais 

rápida do que a disponível para a generalidade das fontes 

(designada por Raytracing).  

4. Hemi: Simula uma fonte de luz hemisférica a grande 

distância (raios paralelos e intensidade constante). Ao contrário 

de todas as outras não provoca sombras (em qualquer dos 

outros 4 tipos a projecção de sombras é uma opção existente 

nos painéis de controle). É útil como complemento de 

iluminação.  

5. Area: Simula uma fonte de luz planar, de área de radiação 

controlável. A utilização deste tipo de fonte constitui o modo 

mais cómodo de produzir sombras de transição suave, embora à 

custa de tempos de renderização muito maiores.  

Inserção de uma fonte de luz . 

As fontes de luz só podem ser criadas em Modo Objecto. Para inserir uma fonte 

de luz numa cena posicione o cursor no local desejado pressione [Space] e 

seleccione o tipo de fonte desejado a partir do menu que surge no ecrã, figura 

1.12.4. O mesmo menu pode ser aberto a partir da opção [Add] na barra da 

Janela de Preferências.  

Figura 1.12.1 

Figura 1.12.2 

Figura 1.12.3 

Figura 1.12.4 



Parâmetros básicos. 

Cada uma das fontes de luz é descrita graficamente por um símbolo diferente. 

A figura 1.12.5 mostra, da esquerda para a direita, uma fonte do tipo lamp, 

sun e spot. Note que para a fonte sun é indicada a direcção dos raios. No caso 

da fonte spot, para além da direcção do foco é indicada a sua abertura. A 

figura 1.12.6 mostra, da esquerda para a direita, uma fonte do tipo hemi e 

uma fonte do tipo area. Para qualquer delas é dada indicação da direcção,

respectivamente perpendicular ao plano do hemisfério e ao plano de radiação. 

Veremos numa próxima abordagem como controlar as características 

particulares de cada uma das fontes de luz, e a sua influência na cena em que

estão inseridas. 

Em seguida seleccione o símbolo correspondente a uma lâmpada no painel que 

surgiu na Janela de Botões, figura 1.12.8, ou pressione repetidamente [F5] até 

que o símbolo fique seleccionado.  

Cada uma das fontes de luz tem características próprias que podem ser 

ajustadas (cor, energia, etc.). Verá surgir na Janela de Botões o conjunto de 

painéis com as diversas propriedades associadas à fonte de luz seleccionada.

Veremos em posterior abordagem o significado de todas as características 

ajustáveis através destes painéis. Por enquanto deter-nos-emos pelas 

características básicas.  

Por exemplo, caso a fonte de luz seja do tipo Lamp, pode ver: o painel 

Preview (comum a todas as fontes), figura 1.12.9, e o painel Lamp, figura

1.12.10, onde pode alterar o Nome do objecto, a Distância a que a fonte de 

luz vê reduzida para metade a sua intensidade (em unidades Blender), a sua 

Energia e a sua Cor. Como pode ver, figura 1.12.9, o tipo de fonte de luz

pode ser alterado após a sua criação, através dos botões existentes no painel 

Preview.  

�

Uma vez colocada a fonte de luz, 

seleccione (Shading) na barra da 

Janela de Botões, figura 1.12.7, ou 

pressione [F5].
 

Figura 1.12.5 

Figura 1.12.6 

 

Figura 1.12.7 

 

Figura 1.12.8 

 

Figura 1.12.9 

 

Figura 1.12.10 

� Teste repetidamente a iluminação resultante de cada um dos tipos de fonte de luz e varie os seus parâmetros para 

observar o seu efeito e se familiarizar com a sua utilização. 

  

  



1 . 1 3  C â m a r a .  

Ao abrir o Blender existe já uma câmara em cena, simbolizada por uma 

pequena pirâmide, figura 1.13.1. Se existir mais que uma câmara em cena, a 

câmara activa, isto é, aquela a que corresponde o ponto de observação da 

Janela Visão de Câmara, e, consequentemente, a imagem a renderizar, [F12], 

tem um triângulo no topo preenchido a negro (caso da câmara à esquerda na 

figura 1.13.1). 

Na Janela Visão de Câmara, figura 1.13.2, a câmara é representada por três 

rectângulos concêntricos. O rectângulo externo, em linha contínua, apenas 

serve para seleccionar a câmara (no exemplo da figura, o rectângulo tem cor

rosa o que significa que a câmara está seleccionada). O rectângulo 

intermediário, em linha tracejada, representa os limites de visualização da 

câmara (correspondente à imagem a renderizar). O interno, em linha 

tracejada, serve de ajuda ao enquadramento dos objectos no campo de visão 

da câmara (zona Title Safe) e pode ser removido. 

Criação e alinhamento. 

Para inserir uma nova câmara proceda de modo idêntico à inserção de um 

objecto elementar: da barra da Janela de Preferências seleccione [Add > 

Camera]. Pode também ter acesso a este menu pressionando [Space]. A 

câmara será inserida no ponto onde se encontra o cursor 3D. O uso de mais do 

que uma câmara é extremamente útil em animação e em jogos 3D. 

Na verdade, qualquer objecto pode ser transformado na câmara activa!  

De imediato a janela onde a acção foi executada passa ao modo Visão de

Câmara, adoptando o ponto de vista do objecto, alinhada com as suas 

coordenadas locais. A mesma acção pode ser desencadeada a partir do menu 

da barra da Janela 3D [View > Camera > Set Active Object as Active 

Camera], figura 1.13.3. 

Tal como para qualquer outro objecto a câmara poder sofrer transformações, 

quer a partir do menu de Transformadores, quer pressionando as teclas , [G], 

[R], ou [S] . No caso do escalamento a acção tem efeito sobre a dimensão do 

símbolo que representa a câmara (pode ter interesse no contexto da 

construção de modelos muito complexos). Com as teclas [G] e [R] podemos 

mover e rodar a câmara, respectivamente, podendo ser evocadas as

sequências [G]>[X], [G]>[X]>[X], etc. para transformações sobre as direcções 

dos eixos coordenados globais ou locais. 

A câmara activa é automaticamente posicionada de modo a adoptar o ponto de 

vista exposto na janela 3D, que passa a ser uma Janela de Visão de Câmara. A 

mesma acção pode ser desencadeada a partir do menu da barra da Janela 3D

[View > Align View > Align Active Camera to View], figura 1.13.4. 

�

Para transformar um objecto na 

câmara activa seleccione o 

objecto desejado e pressione 

[CTRL]+[0] 

�

Um modo simples de fazer o 

alinhamento da câmara é fazer o 

enquadramento desejado numa 

das janelas 3D, através das 

acções de navegação 3D, e 

pressionar [CTRL]+[ALT]+[0]. 

 

 

 

Figura 1.13.1 

Figura 1.13.2 

Figura 1.13.3 

Figura 1.13.4 

 

Figura 1.13.5 



Por último, para proceder ao enquadramento, podemos entrar em Camera Fly

Mode.  

Parâmetros. 

Vamos agora ver como modificar os diversos parâmetros da câmara. 

�

Pressione [Shift]+[F]. Em 

seguida, para mover a câmara 

livremente, movimente o rato ou 

accione [MW ]. Para fixar a 

posição final pressione [LB ].  

�

Uma vez seleccionada a câmara 

pressione [F9], ou seleccione 

[Editing] na barra da Janela de 

Botões, figura 1.13.5.
 

 

Figura 1.13.6 

No painel Camera que surgiu na Janela de Botões, figura 1.13.6, pode controlar os seguintes parâmetros: 

Lens : Define o tipo de lente da câmara (valor padrão 35 mm).  

Orthographic: Comuta a Janela da Câmara entre projecção ortográfica e perspectiva natural.  

Dof Dist: Distância ao ponto de focagem (marcado com uma pequena cruz a amarelo sobre o eixo da câmara (se a opção 

Limits estiver activada). É um parâmetro utilizado em combinação com Defocus Node que permite, por exemplo, simular a 

profundidade de campo (falaremos desta questão mais tarde).  

Dof Ob: Especificação do nome do objecto sobre o qual é feito a focagem (alternativo, e sobrepondo-se, à informação Dof 

Dist). 

Clip Start / End: Define as distâncias, sobre o eixo da câmara, a que se situam os objectos mais próximos e mais 

distantes que estarão presentes na imagem renderizada. Todos os objectos fora deste volume não são representados na 

Janela da Câmara.  

Limits: Activa/desactiva a marcação (com dois pequenos pontos amarelos ao longo do eixo da câmara, unidos por um 

segmento) dos pontos Clip Strat/Clip End.  

Mist: Activa/desactiva a marcação (com dois pequenos pontos brancos ao longo do eixo da câmara) dos limites da Névoa 

(Mist). Mist é uma opção dos painéis do Mundo (World, [F8]), sobre a qual falaremos mais tarde.  

Name: Activa/desactiva a presença do nome da câmara, na Janela da Câmara (inscrito ente o rectângulo de 

enquadramento e o rectângulo de selecção).  

Title Safe: Activa/desactiva o rectângulo interno em linha tracejada presente na Janela da Câmara, figura 1.13.2 (zona 

Title Safe). 

Passepartout: Activa/desactiva o escurecimento (proporcional ao parâmetro Alpha) de toda a zona presente na Janela da 

Câmara, mas que está fora do enquadramento, figura 1.13.2.  

Alpha: Percentagem de escurecimento de toda a zona presente na Janela da Câmara mas fora do seu enquadramento. 

Size: Dimensão do símbolo que representa a câmara na janela 3D, figura 1.13.1. Não altera em nada o enquadramento, e 

portanto a renderização. Tem como único fim facilitar a manipulação do objecto câmara em modelos complexos.  

Shift X / Y: Permite fazer modificações do enquadramento no plano da câmara (referencial local x/y) sem modificar a 

posição da câmara, ou seja, sem modificações de perspectiva. 

Dado o pequeno número de parâmetros, e embora não façamos uso de alguns deles de imediato, optou-se por fazer uma 

descrição exaustiva. Mais tarde, no contexto da sua aplicação, ficará certamente mais clara a sua funcionalidade. Ignore 

por enquanto os parâmetros Dof Dist, Dof Ob e Mist.  

� Teste repetidamente a inserção, comutação, variação de enquadramento e parâmetros de câmaras numa cena, para 

observar o seu efeito e se familiarizar com a sua utilização. 

  

  



1 . 1 4  M a t e r i a i s  0 1 .  

A par da iluminação, a correcta definição das características dos materiais é 

extremamente importante para que se obtenham imagens de qualidade 

fotográfica. Aliás, como veremos, os dois temas têm uma forte ligação entre si: 

a percepção que temos dos diversos materiais presentes no nosso dia a dia 

não é mais do que a percepção do modo como estes tratam a luz que os 

rodeia.  

O número de parâmetros existentes no Blender para definir as características 

dos materiais é bastante elevado. Por agora, para além de vermos como 

associar um material a um objecto, falaremos apenas de alguns dos 

parâmetros básicos. Fa-lo-emos no enquadramento da apresentação de

exemplos de definição das características de materiais de propriedades muito 

distintas uns dos outros, ou seja, que dão à luz um tratamento muito 

diferente. Num próximo módulo abordaremos a questão em todo o seu 

detalhe, analisando cada um dos parâmetros presentes nos painéis associados 

à caracterização de materiais. 

Cor. 

A luz é uma onda electromagnética com comprimentos de onda

aproximadamente entre os 400 e os 800 nano metros (nm=10-9 m), figura 

1.14.1. Ao incidir sobre uma superfície, parte da energia da onda

electromagnética é absorvida e parte é reflectida, sendo que diferentes 

comprimentos de onda são absorvidos em diferentes quantidades, resultando 

daí a nossa percepção da cor do material. Por exemplo, um material sobre o

qual incide luz branca, ou seja, com todas as componentes de cor, é 

percepcionado como vermelho quando reflecte uma significativamente maior 

percentagem da componente vermelha da luz incidente relativamente às

restantes componentes. 

Cor Difusa, Cor Especular, Espelhamento e Transparência. 

À escala do comprimento de onda da luz, muitos materiais tem uma superfície 

extremamente irregular, de onde resulta que a percentagem da luz incidente 

que é reflectida se dispersa, isto é, é re-radiada a partir da superfície com igual 

intensidade em toda as direcções, figura 1.14.2, dando ao material uma cor 

uniforme, sem brilho, figura 1.14.3, como por exemplo temos no caso de uma 

folha de papel, e de superfícies plásticas, tintas e vernizes com acabamento 

mate. Dá-se a este fenómeno o nome de Reflexão Difusa (Diffuse

Reflection). É à luz assim reflectida, que percepcionamos como cor, que 

associamos o conceito de cor do objecto. Em computação gráfica esta cor é

designada por Cor Difusa (Diffuse Color), sendo calculada por algoritmos

designados por Sombreadores Difusos (Difuse Shaders) 

Nos materiais de superfícies mais lisas (em termos de comprimento de onda da 

luz), como sejam metais, plásticos polidos e tintas e vernizes de acabamento 

brilhante, grande parte da energia proveniente de uma determina direcção é 

reflectida segundo uma direcção (ou pelos menos dentro de um ângulo sólido 

de pequena dimensão em torno dessa direcção) que faz o mesmo ângulo com 

a normal à superfície (ângulo de reflexão) que a direcção da luz incidente 

(ângulo de incidência), figura 1.14.4. Dá-se a este fenómeno o nome de 

Reflexão Especular (Specular Reflection). Resultam dai pequenos pontos

brilhantes (highlights) sobre a superfície do material, que correspondem a

imagens das fontes de luz presentes no ambiente, figura 1.14.5. A luz é 

reflectida sem interagir significativamente com o material, pelo que a sua cor 

corresponde, na maioria dos materiais, à cor da fonte luminosa embora para 

alguns materiais assim não seja. Em computação gráfica esta cor é designada 

por Cor Especular (Specular Color), sendo calculada por algoritmos

designados por Sombreadores Especulares (Specular Shaders). 

Figura 1.14.1 

 

Figura 1.14.2 

 

Figura 1.14.3 

 

Figura 1.14.4 

 

Figura 1.14.5 

 

Figura 1.14.6 

 

Figura 1.14.7 



A cor difusa e a cor especular resultam do mesmo processo físico de reflexão 

da luz pela superfície do objecto, sendo a reflexão difusa dominante nos 

materiais em que a luz é dispersa em resultado da rugosidade da superfície, à 

escala dos nm, e a reflexão especular dominante nos materiais de superfícies 

lisas. A figura 1.14.5 resulta da sobreposição dos dois fenómenos, calculados

separadamente por modelos de sombreamento difuso e especular.  

Nos materiais de superfícies excepcionalmente lisas à escala do comprimento 

de onda da luz, como sejam espelhos, metais polidos (nomeadamente 

superfícies cromadas), etc., a luz incidente praticamente não se dispersa, 

sendo a reflexão especular totalmente dominante. Para estes materiais,

praticamente toda a luz envolvente, ou seja, não só a proveniente das fontes 

de luz propriamente dita, mas como toda aquela re-radiada pelos objectos 

próximos, é reflectida pelo material segundo um ângulo de reflexão igual ao 

ângulo de incidência dando origem a uma imagem de toda a cena envolvente 

sobre a superfície do objecto , figura 1.14.7. Este fenómeno de espelhamento 

é tratado em computação gráfica por algoritmos independentes dos

sombreadores difusos e especulares, como, por exemplo, os RayTracers. 

Através destes mesmos algoritmos é possível o tratamento da componente da 

luz incidente que penetra no material, dita componente refractada, e que é 

responsável pelo aspecto transparente e translúcido de alguns materiais, figura 

1.14.6. 

Associação de um material a um objecto. 

Quando abre o Blender, o cubo presente em cena tem já associado um 

material com uma cor difusa correspondente a um tom de cinzento (RGB:[0.8

0.8 0.8]). Todos os novos objectos que inserir não ficam com qualquer 

material associado. No entanto, e por comodidade de manipulação, são 

representados no mesmo tom cinzento difuso, apenas com ligeiras variações

conforme o Modo de Representação, , seja Solid, Shaded ou Textured 

(apenas a esfera é representada com brilho para facilitar a percepção da sua 

tri-dimensionalidade), figura 1.14.8.  

Se o objecto não tiver nenhum material associado verá surgir na Janela de 

Botões o painel da figura 1.14.10. Pressione o botão [Add New]. O objecto

passou a ter um material associado.  

Surgirão na janela de botões diversos painéis, entre os quais o painel 

Material, figura 1.14.11. O objecto passou a ter associado um material de cor 

difusa (RGB:[0.8 0.8 0.8]), Col no painel. Se desejar pode modificar a cor 

difusa do objecto editando os valores RGB, [SHIFT> [LB ], movendo os

sliders, [LB ], ou ainda, pressionando, [LB ], o rectângulo colorido à 

esquerda e fazendo a selecção de cor a partir do painel que surge, figura 

1.14.12. 

Em qualquer altura pode ter acesso aos Painéis de Materiais pressionando 

[F5] e seleccionando Material Buttons, figura 1.14.6 (ou pressionando 

sucessivamente [F5] até que Material Buttons fique seleccionado). 

No painel Links and PipeLine, figura 1.14.14, surgiu um novo conjunto de 

botões. Editando o campo MA pode alterar o nome padrão e dar um nome 

específico ao material criado, de modo a facilitar a sua identificação, por 

exemplo, para que possa ser facilmente identificado quando se pretender fazer 

a sua associação a outros objectos. 

�

Seleccione um objecto e em seguida 

seleccione [Shading] na barra da 

Janela de Botões, figura 1.14.9, ou 

pressione [F5].
 

 

Figura 1.14.8 

 

Figura 1.14.9 

 

Figura 1.14.10 

 

Figura 1.14.11 

 

Figura 1.14.12 

 

Figura 1.14.13 



Difuse Shaders. 

A Cor Difusa pode ser calculada no Blender por diversos Algoritmos de 

Sombreamento Difuso (Difuse Shaders), Lambert, Toon, etc., que podem ser 

encontrados no painel Shaders, figura 1.14.16. Embora o número de 

parâmetros seja dependente do método, todos têm como parâmetros comuns 

a cor difusa, Col (como vimos especificada no painel Materials, figura 1.14.11), 

e a percentagem da energia incidente que é reflectida (coeficiente de reflexão), 

Ref, figura 1.14.16. Analisaremos cada um dos métodos, as suas diferenças e 

o significado dos seus parâmetros numa próxima abordagem do tema 

materiais. 

Na imagem anteriormente obtida, figura 1.14.5, foram utilizados os valores 

padrão (Lambert, Ref[0.8]). Não há necessidade de caracterizar

diferenciadamente os objectos presentes em cena relativamente à reflexão 

difusa pelo que vamos manter o coeficiente de reflexão padrão Ref[0.8]. 

Specular Shaders. 

A Cor Especular pode ser calculada no Blender por diversos Algoritmos de 

Sombreamento Especular (Specular Shaders), Phong, Toon, etc., que, tal 

como os Difuse Shaders podem ser encontrados no painel Shaders, figura 

1.14.17. Embora o número de parâmetros seja dependente do método, todos

têm como parâmetros comuns a cor especular, Spe, especificada no painel 

Materials, figura 1.14.11, e a intensidade ou luminosidade do ponto brilhante 

correspondente à imagem da fonte de luz, Spec, figura 1.14.7. O valor de 

Spec varia na gama [0 2.0], o que fisicamente não faz sentido, já que permite 

que a energia reflectida seja superior à incidente, mas permite obter efeito 

gráficos interessantes.  

Vamos utilizar o sombreador padrão CookTorr. Na imagem anteriormente 

obtida, figura 1.14.5, foram utilizados os valores padrão (CookTorr, Spec[0.5],

Hard[50]). O parâmetro Hard do sombreador CookTorr permite controlar a 

dimensão da mancha luminosa. Varia na gama [1 511], sendo a zona brilhante 

de raio tão mais pequeno quanto mais elevado for o valor de Hard. Vamos 

agora caracterizar diferenciadamente os objectos presentes em cena

relativamente à reflexão especular. 

• Abra o Blender, insira duas esfera, um toroide e um cubo, 

e faça um enquadramento semelhante à figura 1.14.15. 

(esfera1: xyz[-2 -2 1]; esfera2: xyz[-0.5 -1.5 0.5], DxDyDz

[1 1 1]; cubo1: xyz[0 0 1], RxRyRz[0 0  70]; torus: xyz[0.75 

-2 1], RxRyRz[60 0 35].camera: xyz[0 -10 7] RxRyRz[60 0 

0]; cubo2: xyz[-1.5 -1 -0.1] DxDyDz[3.7 5 0.2]; 

• Elimine a fonte lamp e insira uma fonte Hemi e uma fonte 

Spot. Hemi: xyz[0 0 20], Dist[10]; Spot: xyz[-20, -10 10], 

RxRyRz[50 0 -50]. Dist[30]. 

• Em TopView insira um plano sob os objectos que ocupe 

todo o enquadramento da câmara. plano1: xyz[0 0 -0.1], 

DxDyDz[50 50 0]. 

• Seleccione a esfera1, atribua-lhe um novo material, e 

modifique a Cor Difusa para Col[1.0 0.85 0.5].  

• Seleccione a esfera2, atribua-lhe um novo material, e 

modifique a Cor Difusa para Col[1.0 0.85 0.5].  

• Seleccione o toroide, atribua-lhe um novo material e 

mantenha a cor padrão Col[0.8 0.8 0.8].  

• Seleccione o cubo2, atribua-lhe um novo material e 

mantenha a cor padrão Col[0.8 0.8 0.8]. 

• Seleccione o plano, atribua-lhe um novo material, e 

modifique a Cor Difusa para Col[0.75 0.4 0.1].  

• Pressione [F10] para observar a imagem resultante, figura 

1.14.15. 

 

Figura 1.14.14 

Figura 1.14.15 

 

Figura 1.14.16 

 

Figura 1.14.17 



Raytraced Reflections. 

Vamos agora ver como obter efeitos de espelhamento e transparência. Existem 

vários modos de obter estes efeitos no Blender. Vamos ver como o podemos 

fazer recorrendo ao algoritmo de RayTracing utilizando apenas os parâmetros 

básicos. Veremos mais tarde todos os detalhes dos parâmetros disponíveis,

assim como os outros algoritmos existentes.  

Active o painel Mirror Tansp, figura 1.14.19, pode ver à esquerda o conjunto 

de parâmetros associados ao espelhamento e à direita os parâmetros 

associados à transparência.  

Para obter qualquer efeito de espelhamento active o botão Ray Mirror. O 

parâmetro RayMir controla o grau de reflectividade do material, variando no 

intervalo [0.0 1.0]: 0.0 para uma reflectividade nula e 1.0 para um espelho 

perfeito. Alguns materiais alteram a cor da imagem por eles reflectida, 

transmitindo-lhe características da sua própria cor. No painel Materials, figura 

1.14.11, este efeito pode ser activado modificando o valor RGB da cor de

espelhamento, definida pelo parâmetro Mir. 

Para obter qualquer efeito de transparência active o botão Ray Transp. O 

parâmetro IOR (índice de refracção), variando no intervalo [1.0 3.0],

determina o ângulo que a luz refractada faz com a luz incidente, e daí o grau 

de distorção das imagens vistas através do material (os índices de refracção 

dos materiais estão tabelados. Procure-os na net ou num livro de física). Para 

obter um material transparente é ainda necessário alterar o valor do 

parâmetro A (Alpha) no painel Material. O parâmetro A varia na gama [0.0 

1.0]: 0.0 para um material completamente transparente e 1.0 para um 

material totalmente opaco.  

• Seleccione a esfera1 e faça: Spec[0.9]; Hard[25]. Ou seja, 

aumente o brilho e a dimensão do reflexo luminoso. Altere a 

cor especular para Spe[0.75 0.5 0.1].  

• Seleccione a esfera2 e faça: Spec[1.5]; Hard[414]. 

• Seleccione o toroide e faça: Spec[1.1]; Hard[347]. 

• Seleccione o cubo1 e faça: Spec[2.0]; Hard[511]. 

Ou seja, aumente o brilho e diminua a dimensão do reflexo 

luminoso em cada um destes 3 objectos.  

• Pressione [F10] para observar a imagem resultante, figura 

1.14.18. 

Figura 1.14.18 

 

Figura 1.14.19 

Figura 1.14.20 

• Seleccione a esfera1. No painel Mirror Transp active Ray Mirror e faça: RayMir[0.4]. No painel Material 

altere a cor de espelhamento para Mir[0.75 0.5 0.1].  

• Seleccione o toroide. No painel Mirror Transp active Ray Transp e faça: IOR[1.38]. No painel Material faça 

Alpha[0.0].  

• Seleccione o cubo1. No painel Mirror Transp act ive Ray Mirror e faça: RayMir[0.4]. No painel Material altere 

a cor de espelhamento para Mir[0.75 0.5 0.1].  

Ou seja, aumente o brilho e diminua a dimensão do reflexo luminoso em cada um detes 3 objectos.  

• Pressione [F10] para observar a imagem resultante, figura 1.14.20. 

� Explore os conceitos básicos sobre caracterização de materiais que aqui foram apresentados até se familiarizar com a 

sua utilização. Procure caracterizar materiais específicos. Reproduza a cena descrita no texto e salve-a num ficheiro. 
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A maior parte dos materiais não tem uma cor uniforme, apresentando

variações de cor, aleatoriamente ou seguindo um padrão, ou pequenas 

irregularidades, que provocam variações de tom da cor base, figura 1.5.1. De

modo a simular estas variações é necessário adicionar uma textura ao material

associado ao objecto. 

Associação de uma textura a um material. 

Só se pode caracterizar a superfície de um determinado objecto com uma 

textura depois de se ter associado um material a esse objecto. Melhor dizendo, 

a textura é associada a um material, que passa a ter mais essa característica, 

para além da sua cor difusa, índice de transparência etc.  

Verá surgir na Janela de Botões o painel Texture, figura 1.15.3. Pressione 

[Add New]. O painel assumirá o aspecto da figura 1.15.4. Pressione os 

cursores junto à caixa [None] e poderá seleccionar uma das 13 texturas 

disponíveis. A textura seleccionada passou a ser mais uma das características

do material associado ao objecto.  

Ao seleccionar uma textura, surgirá um novo painel com o conjunto de

parâmetros relevantes que lhe está associado. Falaremos de cada uma das 

texturas e dos seus parâmetros num próximo módulo. 

Pressione [F5] para voltar ao Painéis de Materiais.  

Mapeamento de uma textura. 

A textura seleccionada passou a constar no painel Texture (do ambiente

Painéis de Materiais), figura 1.15.5. Como pode ver, é possível associar 10 

texturas diferentes a um só material. Surgiram ainda 2 novos painéis: Map

Input e Map To.  

No painel Map Input, figura 1.15.6, existe um conjunto de parâmetros que 

determinam o modo como a textura é mapeada na superfície do objecto a que 

o material está associado. Fundamentalmente, está em causa o modo como as 

coordenadas do objecto se relacionam com as coordenadas das texturas. 

Apesar do elevado número de parâmetros é um procedimento bastante simples 

que abordaremos mais tarde. 

No painel Map To, figura 1.15.7, existe um conjunto de parâmetros que 

determinam quais são as características do material que a textura vai afectar e 

o modo como o faz. É um procedimento bastante complexo que abordaremos

mais tarde em detalhe. 

Exemplos. 

De modo a ganhar alguma sensibilidade quanto à utilização de texturas, vamos

ver alguns exemplos simples de texturização de materiais. 

Abra o ficheiro que criou na aula sobre materiais. 

�

Seleccione um objecto a que já tenha 

associado um material e em seguida 

seleccione [Texture buttons] na 

barra da Janela de Botões, figura 

1.15.2, ou pressione [F6].

 

 

Figura 1.15.1 

 

Figura 1.15.2 

 

Figura 1.15.3 

 

Figura 1.15.4 

 

Figura 1.15.5 



Com a matriz XYZ pode alterar a relação entre as coordenadas da textura e as 

coordenadas (locais) do objecto (por exemplo para inverter a posição da 

textura), e com os parâmetros ofsX, ofsY e ofsZ, e sizeX, sizeY e sizeZ pode, 

respectivamente, transladar e escalar a textura. 

A maior parte dos parâmetros são auto-explicativos, nomeadamente em

resultado da observação do painel Preview. Veremos todos os detalhes num 

próximo módulo.  

Vamos por agora dar apenas uma pequena explicação sobre o parâmetro Nor

do painel Map To. Aos desseleccionar Col desactivámos a influência que a 

textura tem sobre a cor do material. Activando Nor a textura passa a ter 

influência sobre as normais à superfície do objecto, criando ondulações

(apenas em termos de renderização, isto é, não sofrendo o modelo 3D 

qualquer influência). A técnica pode ser usada para criar a ilusão de pequenas 

ranhuras na superfície dos objectos, zonas de aspecto envelhecido, etc., sendo 

a gama de efeitos muito diverso, nomeadamente quando a técnica é conjugada 

com outras texturas. 

• Mapeie uma textura do tipo imagem no cubo2: Pressione 

[F6]>Add New>Image>Load. Mantenha as opções padrão. 

Proceda de igual modo para a esfera 2.  

• Pressione [F10] para observar a imagem resultante, (Algo 

semelhante à figura 1.15.8).  

• Mapeie uma textura do tipo Clouds no plano2: Pressione 

[F6]>Add New>Image>Clouds. Mantenha as opções padrão. 

Volte aos painéis de materiais, [F5]. Pressione [F10] para 

observar a imagem resultante. 

• Seleccione o painel Map To e altere os valores RGB para 

[0.85 0.6 0.3]. Pressione [F10] para observar a imagem 

resultante. 

• Seleccione o Painel Map Input e faça sizeY[10]. Pressione 

[F10] para observar a imagem resultante. 

• Seleccione o painel Texture, seleccione o slot da 2ª textura 

e pressione Add New. Pressione [F6] e  mapeie uma textura 

do tipo Wood. No painel Wood seleccione RingNoise e faça 

Turbulence[20]. 

• Volte aos painéis de materiais, [F5], e seleccione o painel 

Map To. Desseleccione Col e Seleccione Nor. Pressione [F10] 

para observar a imagem resultante. 

• Seleccione o painel Map Input e faça SizeXSizeYSizeZ[0.1 

20 0.1]. Pressione [F10] para observar a imagem resultante. 

(Algo semelhante à figura 1.15.9).  

 

Figura 1.15.6 

 

Figura 1.15.7 

Figura 1.15.8 

Figura 1.15.9 

� Explore os conceitos básicos sobre texturização aqui apresentados até se familiarizar com a sua utilização. Procure 

caracterizar materiais específicos. Reproduza a cena descrita no texto e salve-a num ficheiro. 
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Abra o seu ficheiro exercício3#####.blend.  

Utilizando apenas os conhecimentos que adquiriu até aqui, atribua a cada uma das componentes da caneta materiais com

características semelhantes aos da figura 1.16.1. 

Coloque a caneta sobre um plano, crie uma textura semelhante a um qualquer tipo de madeira e associe-a ao material do plano.  

Faça um enquadramento semelhante à figura 1.16.1 e salve o ficheiro com o nome exercicio04#####.blend, fazendo corresponder 

os cardinais ao seu número de aluno. 

 

Figura 1.16.1 
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A animação consiste na modificação da posição, da forma ou de uma qualquer 

outra característica visível de um objecto ao longo do tempo, e é conseguida 

muito simplesmente através da apresentação de uma sequência de imagens

a um ritmo suficientemente elevado (por exemplo o padrão PAL é de 25 

imagens por segundo) para que, em resultado da persistência da visão, possa

criar a ilusão evolução contínua. 

Por exemplo, dispondo os modelos 3D que deram origem à figura 1.15.9 em 

250 diferentes posições, procedendo à renderização de cada um dos 

enquadramentos, e mostrando as 250 imagens obtidas a um ritmo de 25 

imagens por segundo, criamos a animação de 10 segundos que se mostra em 

animação 1.17.1.  

Seria uma tarefa extremamente morosa se tivesse que ser feita

enquadramento a enquadramento. Como veremos, existem no Blender 

diversas funcionalidades que permitem reduzir muito significativamente o 

tempo de produção de uma animação. Ainda assim, há um dos aspectos que 

não pode ser contornado: o tempo de renderização de cada uma das imagens. 

Sendo uma sequência de imagens, uma animação pode ter tanta qualidade 

quanta a julgada necessária. Dependendo da complexidade da iluminação e 

das características dos materiais envolvidos, uma imagem pode demorar de 

alguns segundos a alguns dias a renderizar. Por exemplo, se a cada uma das 

imagens de uma animação estiver associado um tempo de renderização de 

uma hora, as 1500 imagens de um pequeno filme de 25 minutos de duração 

demorarão dois meses a ser renderizadas. 

No Blender, a animação pode ser conseguida em resultado de uma sequência 

de 3 diferentes tipos de acções: 

� Actuar sobre o objecto como um todo, modificando a sua posição 

ou dimensões ao longo do tempo. Vimos já como isso pode ser feito 

(ex: teclas R, G, S).  

� Actuar sobre os elementos que constituem o modelo 3D do 

objecto (vértices, etc.), modificando a sua forma ao longo do tempo. 

Vimos alguns princípios rudimentares de modelação. Veremos

proximamente diversas técnicas de modelação, e em particular as 

funcionalidades de alteração de forma criadas com o fim específico de 

fazer animação.  

� Actuar sobre uma armadura interna ao objecto. Existe no Blender 

um sistema articulado, designado por Armadura, que constitui uma 

espécie de esqueleto do objecto, facilitando a obtenção de movimentos 

articulados (como por exemplo o andar, saltar, etc.).  

Vamos por enquanto ver apenas os aspectos básicos do primeiro ponto acima. 

Voltaremos ao tema animação por diversas vezes ao longo do semestre, 

analisando técnicas sucessivamente mais complexas. 

1.17.1 Animação recorrendo ao Motor de Jogo. 

O modo mais simples de obter uma animação em Blender é recorrendo ao seu 

motor de jogo integrado. Foi assim que foi feita a animação 1.17.1. 

Graças ao motor de jogo é possível atribuir uma massa a um qualquer objecto

e inseri-lo num mundo em que fica sujeito às leis da Física (da Mecânica), 

passando o objecto a reagir à força da gravidade, às forças de atrito, 

resistência do ar, etc. Para obter uma animação basta então gravar o modo 

como o "jogo" evolui. Passemos a ver um exemplo simples, para não perder 

tempo com o processo de renderização. Não serão dados detalhes 

relativamente ao botões e painéis do motor de jogo. Abordaremos a questão

na próxima aula. 

 

Animação 1.17.1 

 

Figura 1.17.1 

 

Figura 1.17.2 

 

Figura 1.17.3 

Figura 1.17.4 

 

Figura 1.17.5 



Seleccione [Shading] na barra da Janela de Botões, ou pressione [F5], e em 

seguida seleccione o símbolo com o planeta Terra, figura 1.17.1, para ter 

acesso aos painéis de controlo do Mundo (World), World Buttons. No Painel

Mist/Stars/Physics, figura 1.7.2, é possível alterar o valor da força de 

gravidade a que os objectos estão sujeitos, enquanto actores do mundo. 

Seleccione um objecto e em seguida seleccione [Logic] na barra da Janela de 

Botões, figura 1.17.3, ou pressione [F4], para ter acesso ao painéis do Motor 

de Jogo (Game Engine, GE). Se pressionar o botão no topo esquerdo, 

[Actor], o Motor de Jogo passa a considerar o objecto seleccionado como um

personagem, ou actor, do mundo em que está inserido, e a processá-lo 

conforme as características que em seguida se definirem nos botões que ficam 

disponíveis. Por agora apenas nos interessa o botão [Dynamic] que, uma vez 

pressionado, determina que o actor fica sujeito às leis da Mecânica. 

Na barra do Janela de Preferências, o opção [Game] abre um menu em que se 

podem seleccionar diversas opções do GE. Seleccione [Record Game Physics 

to IPO]. O GE passa a registar a evolução ao longo do tempo dos actores 

presentes no Mundo em que o Jogo se desenrola (veremos já de seguida o 

significado do termo IPO). 

O motor de jogo é accionado colocando o cursor do rato sobre a Janela 3D e 

pressionando a tecla [P], ou fazendo a respectiva selecção no menu acima 

referido, figura 1.17.5. Para sair do GE pressione [Esc].  

Se tiver sido accionado o registo IPO das ocorrências do jogo, esta podem ser 

revistas colocando o rato sobre uma qualquer Janela 3D e pressionando as 

teclas [Alt][A].  

Características Vídeo. 

Antes de continuar a apresentação dos conceitos básicos sobre animação 

vamos ver como podemos especificar as características do vídeo 

correspondente à sequência de imagens renderizadas. 

Pressione [F10], ou, seleccione [Render] na barra da Janela de Preferências e 

seguidamente [Render Settings], figura 1.17.7, ou ainda, na barra da Janela 

de Botões seleccione [Scene] seguido de [Render Buttons], figura 1.17.8. 

Surgem na Janela de Botões os painéis das figuras 1.17.9 a 12.  

• Abra o Blender. Insira um plano em TopView, aumente a 

suas dimensões e coloque-o na origem xyz[0 0 0], DxDyDz[8 

8 0]. Eleve o cubo acima do plano e reduza-lhe as 

dimensões: xyz[0 0  4], DxDyDz[1 1 1]. Passe a CameraView. 

Deve obter um enquadramento semelhante à figura 1.17.6. 

• Seleccione o cubo, seleccione [Logic] na barra da Janela de 

Botões, ou pressione [F4]. Pressione o botão [Actor], e em 

seguida o botão [Dynamic]. Na barra do Janela de 

Preferências, seleccione [Game] e [Record Game Physics to 

IPO]. 

• Coloque o rato sobre a janela 3D e pressione [P]. Verá que 

o cubo se desloca em direcção ao plano (estando sujeito à 

força da gravidade tem um movimento uniformemente 

acelerado segundo o eixo dos zz). Quando o cubo atingir o 

plano pressione [Esc] para sair do GE. 

• Coloque o rato sobre a janela 3D e pressione [Alt][A]. É 

mostrada a sequência de enquadramentos que darão origem 

às imagens que const ituirão a animação (uma vez feita a 

renderização). No pequeno quadrado negro que surge sobre 

a Janela 3D pode ver o número correspondente ao 

enquadramento (Frame) que está a ser apresentado. A 

mesma informação é dada no canto inferior esquerdo da 

Janela 3D, figura 1.17.6.  

Figura 1.17.6 

Figura 1.17.7 

 

Figura 1.17.8 

 

Figura 1.17.9 

 

Figura 1.17.10 

 

Figura 1.17.11 



No Painel Format, figura 1.17.9, pode optar por um dos formatos pré-

definidos (PAL, NTSC, etc.), ou especificar as dimensões da imagem nas caixas

[SizeX/SizeY], o número de imagens por segundo na caixa [FPS], e ainda o 

formato do ficheiro em que deseja gravar a animação (Mov, Mpeg, Avi, etc.). 

No Painel Render, figura 1.17.10, pode alterar as dimensões da imagem 

especificado no Painel Format, especificando uma percentagem dessa 

dimensão (a opção é útil para reduzir o tempo de renderização durante a fase 

de concepção da animação. No Painel Anim, figura 1.17.11, nas caixas

[Sta/End] pode especificar o número das frames por que deseja que a sua

animação seja composta. Se pressionar o Anim dá início ao processo de

renderização da sequência. Terminado o processo pode ver o vídeo final 

pressionando o botão Play. No Painel Output, figura 1.17.12, pode especificar 

a directoria em de deseja gravar o ficheiro vídeo e ainda em que janela e em 

que posição do ecrã deseja ver o processo de renderização. Durante a

evolução da composição do ficheiro vídeo pode ver o número da frame que 

está a ser renderizada no canto superior direito da janela de renderização, 

figura 1.17.3. A mesma informação pode ser vista na consola DOS, figura 

1.17.14.  

1.17.2 Animação por Key Frames. 

A animação por recurso ao motor de jogo, embora expedito, é um processo de 

resultados limitados a animações associadas a movimentos resultantes das leis

da mecânica. Tendo intitulado este processo como o mais simples, digamos

então que o que agora vamos ver, Animação por Quadros Chave

(KeyFrames) é o mais básico. Na verdade os conceitos que agora vão ser

apresentados constituem a base de todas as animações feitas em Blender. 

Dado que uma animação consiste na mudança ao longo do tempo de um 

qualquer aspecto visível do enquadramento a renderizar, é necessário a

existência de um mecanismo que registe essas modificações. Por outro lado, 

dado que o número de enquadramentos necessários para produzir uma 

animação é extremamente elevado, é necessário um mecanismo que

automatize a construção de cada um dos enquadramentos com base nas 

modificações que é necessário introduzir relativamente aos enquadramentos

anteriores.  

No Blender, como na maior parte do sofware de animação 3D, o registo das 

características de um enquadramento especialmente relevante no fluxo da

animação é feito num Quadro Chave (KeyFrame), e o cálculo das

características dos enquadramentos entre cada uma das KeyFrames é feito por 

interpolação e registado em Curvas IPO (de InterPOlation). 

• Pressione [F10]. Seleccione um formato vídeo e especifique 

Sta/End[1 50] (isto é, renderize apenas 50 frames). Após 

terminado o processo pressione [Play] e observe a animação, 

animação 1.17.2.  

 

Figura 1.17.12 

Figura 1.17.13 

Figura 1.17.14 

 

Animação 1.17.2 

 

Figura 1.17.15 



Voltemos ao exemplo do cubo 

que cai em direcção ao plano, 

cuja dinâmica foi calculada pelo 

motor de jogo e registada sem 

qualquer intervenção da nossa 

parte (recorde que 

seleccionámos [Record Game

Physics to IPO], figura 1.17.5). 

Na barra da Janela de 

Preferências seleccione a pré-

configuração de janelas, 

Animation, figura 1.17.15. 

Figura 1.17.16 

Surgiram no ecrã dois novos tipos de janelas: a Janela de Edição de Curvas 

IPO (IPO Curve Editor), ou simplesmente Janela IPO e a Janela de Tempo

(Timeline), figura 1.17.16. As duas janelas têm funcionalidades 

complementares e podem substituir qualquer das janelas do ambiente de 

trabalho pelo método habitual, figura 1.17.17.  

Vamos ignorar por agora a Janela de Tempo e explorar as funcionalidades 

básicas da Janela IPO. Voltaremos ao assunto num próximo módulo. 

Seleccione o cubo. Na Janela IPO pode ver uma série de curvas que descrevem 

a evolução temporal das características do cubo relevantes para a presente 

animação. Estas características, chamadas neste contexto Canais IPO, estão 

especificadas na barra vertical cinzenta à direita da janela IPO. Cada uma das 

curvas é representada na cor correspondente ao pequeno rectângulo à 

esquerda da designação do canal IPO. Pressione o rectângulo à esquerda de 

LocZ. Ficará visível apenas a curva que representa a coordenada Z da posição 

do centro do cubo (representada no eixo vertical) relativamente ao nº de

ordem da frame na animação (escala horizontal), figura 1.17.16. 

Note que a curva locZ é representada a amarelo. No caso da figura 1.17.6 a 

coloração rosa deve-se ao facto de a janela IPO estar em Edit Mode e os

pequenos rectângulos sobre a curva se encontrarem não seleccionados. Cada 

um destes pequenos rectângulos, um por frame, corresponde a uma 

KeyFrame, estando representados na Janela Tempo pelas linhas verticais a

amarelo. A curva IPO foi gerada pelo GE que simplesmente cria uma KeyFrame 

por cada imagem a renderizar. 

Vamos agora ver como criar uma animação idêntica à acima descrita mas sem 

recurso ao GE.  

• Abra o Blender. Insira um plano em TopView, aumente a 

suas dimensões e coloque-o na origem xyz[0 0 0], DxDyDz[8 

8 0]. Eleve o cubo acima do plano e reduza-lhe as 

dimensões: xyz[0 0  4], DxDyDz[1 1 1]. Passe a CameraView. 

Deve obter um enquadramento semelhante à figura 1.17.6. 

• Subdivida a Janela 3D é coloque à direita uma Janela IPO.  

 

Figura 1.17.17 

 

Figura 1.17.18 



Verifique que o número entre parêntesis no canto inferior esquerdo da Janela 

3D, correspondente à frame em edição, é (1) . Vamos agora informar o Bloco 

IPO que a 1ª frame é uma KeyFrame. 

• Seleccione o cubo e pressione [I]. 

Um menu onde pode seleccionar o Canal IPO que deseja registar, figura 

1.17.18, surge no ecrã (as opções presentes no menu dependem do tipo de 

objecto que seleccionou).  

• Seleccione [LocRot]. 

Com esta opção regista a informação relativa às coordenadas do centro do 

objecto e à rotação dos eixos coordenados locais relativamente às coordenadas 

globais. Na janela IPO surgirão duas linhas constantes. Vamos agora avançar 

para a frame 50 da animação recorrendo aos cursores.  

• Avance para a frame 50. Seleccione o cubo e desloque-o em 

direcção à origem: xyz[0 0 0.5 ]. Pressione [I] de modo a inserir 

uma nova KeyFrame e seleccione [LocRot]. 

A curva IPO a amarelo (LocZ) assumiu a forma da figura 1.17.19. O valores da

coordenada z do centro do cubo, entre as frames 1 e 50 foram calculadas por 

interpolação e registadas no respectivo canal IPO.  

• Coloque o cursor sobre a janela 3D, pressione [ShiftL] +[�] 

para saltar para a 1ª frame e em seguida [Alt]+[A] para pré-

visualizar a animação.  

Edição de curvas IPO. 

As curvas IPO podem ser editadas quer como um todo, quer actuando sobre 

cada um dos pequenos rectângulos representativos das KeyFrames, de modo

semelhante às acções na janela 3D sobre os objectos em Modo Objecto ou 

sobre os vértices da sua malha em Modo Edição (teclas G, R, S, etc.) .  

Para inserir uma KeyFrame pressione 

[I].  

[�]  Avança 10 frames. 

[�]  Recua 10 frames. 

[�]  Avança 1 frame. 

[�]  Recua 1 frame. 

[ShiftL] +[�]  Avança para a última frame. 

[ShiftL] +[�]  Recua para a 1ª frame. 

Figura 1.17.19 

Figura 1.17.20 

Figura 1.17.21 



Note que a curva da figura 1.17.19 é diferente da curva da figura 1.17.16. A 

curva 1.17.16 resultou do cálculo, pelo GE, do movimento uniformemente 

acelerado do cubo em direcção ao plano. A curva 1.17.19 resultou do modo de 

interpolação padrão que está seleccionado e corresponde a uma curva de

Bezier.  

• Seleccione apenas a curva IPO LocZ (certifique-se de que não 

estão seleccionadas todas as curvas IPO. [A] 

selecciona/desselecciona todas as curvas). Pressione [Tab] para 

entrar em modo edição. Pressione [A] para desseleccionar todas 

as KeyFrames. Seleccione o controlador de Bezier mais à 

esquerda da 2ª KeyFrame, figura 1.17.20. Pressione [G] e 

arraste o controlador para cima e para fora, figura 1.17.21. 

• Coloque o cursor sobre a janela 3D pressione [ShiftL] +[�] 

para saltar para a 1ª frame e em seguida [Alt]+[A] para pré-

visualizar a animação.  

A curva é agora semelhante à figura 1.17.16, simulando um movimento 

uniformemente acelerado. 

Figura 1.17.22 

Em qualquer altura pode ir à janela 3D e inserir uma

nova KeyFrame com as características que desejar, e de

seguida voltar à janela IPO e editar as curvas como 

considerar conveniente. Pode também inserir uma nova

KeyFrame na janela IPO ([Ctrl]+[LB ] sobre a curva 

em modo edição) e alterar as suas característica na 

janela IPO ou na janela 3D. Veremos todos os

pormenores sobre Curvas IPO e KeyFraming num 

próximo módulo. 

Para replicar parte da curvas IPO o processo é 

semelhante à duplicação de elementos de uma malha na

janela 3D.  

• Reproduza a curva IPO da figura 

1.17.22: Insira 3 novas KeyFrames e 

dê à curva uma forma semelhante à 

da figura pelo método que desejar 

(nota: Tal como na janela 3D pode 

recorrer ao auxilio da janela de 

transformações, pressionando [N], 

para obter uma maior precisão). 

Figura 1.17.23 

Em Modo Edição, podemos seleccionar um conjunto de KeyFrames com [Shift]

+ [RB ] sobre cada uma delas, ou pressionando [B] e arrastando o 

rectângulo de selecção. Após feita a selecção, [Shift]+[D] duplica o conjunto 

de KeyFrames seleccionado, que pode ser arrastado com o rato para a posição 

desejada. 

Se desejar repetir periodicamente um determinado comportamento, o modo 

mais prático é recorrer ao Modo Expandido (IPO Extended Mode). O Modo 

Expandido determina a maneira como as curvas IPO evoluem para além dos 

limites da primeira e última KeyFrame, ou seja, como a curva é extrapolada. 

Veremos pormenores mais tarde. Por agora vamos ver como usar o modo 

expandido para criar um movimento ciclíco. 

 

Figura 1.17.24  



Para aceder ao Modo Expandido seleccione [Curve>Extended Mode] da barra 

da Janela IPO, figura 1.17.23, ou, com o rato sobre uma janela IPO, pressione

[E], figura 1.17.24. Para repetir ciclicamente o comportamento que a curva 

IPO assume dentro dos limites da primeira à última KeyFrame seleccione 

[Cyclic]. 

1.17.3 Curvas Path. Animação com Restritores.  

Embora qualquer dos tipos de curvas disponíveis no Blender possa ser utilizada 

como elemento condicionador do movimento de um objecto, existe no Blender 

um tipo especial de curva, designada por Path, que tem características

especiais que facilitam a sua utilização em animação. 

• Pressione [Space] e seleccione [Add>Curve>Path], figura 

1.17.25. Para facilitar a manipulação do Path deve inseri-lo 

sobre um plano coordenado, isto em TopView, SideView, etc. 

A curva Path tem associada uma direcção de evolução e tem, por defeito, 5 

controladores de forma, figura 1.17.26. Seleccionando os controladores, em 

Modo Edição, a curva pode tomar a forma que se deseja dar ao percurso a

seguir pelo objecto. Pode adicionar novos controladores seleccionando o 

controlador de um dos extremos e pressionando [Ctrl]+[LB ], pode 

seleccionar vários controladores em simultâneo, mantendo [Shift] pressionado 

em cada uma das selecções, pode fechar o percurso pressionando [C], etc.. 

Num próximo módulo analisaremos a questão em detalhe. 

Um vez criado o percurso desejado é necessário associar o objecto que

desejamos animar a esse percurso. Para isso seleccionamos o ambiente

[Object>Object Buttons] na janela de botões, [F7], figura 1.17.27, e, no 

Painel Constraints seleccionamos [Add Constraint> Follow Path], figura 

1.17.29. O Painel Constraints assume a forma da figura 1.17.28. Na caixa OB

inscreva o nome do Path. A caixa imediatamente acima deve mudar de cor. 

Caso contrário inseriu mal o nome do Path. 

Na janela IPO, seleccionando o tipo de curvas Path, 1.17.30, podemos 

controlar o modo como o objecto percorre o Path modificando a forma da curva

Speed. Por defeito, a Path é percorrido em 100 frames. Pode alterar esse valor

seleccionando os controladores da curva e dando-lhe o valor desejado. A

edição da curva Speed é idêntica à de qualquer das curvas IPO. 

Pode criar várias curvas Path e tomar qualquer delas como um objecto a que 

associa um restritor Follow Path, como acima ficou descrito. Isto é, pode 

obrigar uma curva Path a percorrer o percurso definido por outra curva Path. 

Podemos associar qualquer objecto a uma curva Path, uma lâmpada, uma

câmara, etc.. No caso da associação de uma câmara a uma curva Path, e de 

modo a que a câmara aponte sempre para um alvo desejado, devemos 

associar-lhe um novo restritor: Track To, figura 1.17.29. Enfim, as opções são 

ilimitadas. Veremos todos os pormenores num próximo módulo.  

• Na Janela IPO seleccione a curva LocZ, pressione [E] e 

seleccione [Cyclic]. A curva assume o comportamento que se 

mostra na janela 1.17.23.  

• Coloque o rato sobre a janela 3D e pressione [Alt][A] para 

pré-visualizar animação. 

• Pressione [F10]. Seleccione um formato vídeo e especifique 

Sta/End[1 250]. Após terminado o processo pressione [Play] 

e observe a animação, animação 1.17.3.  

 

Animação 1.17.3 

Figura 1.17.25 

Figura 1.17.26 

 

Figura 1.17.27 

  

 

Figura 1.17.28 



 

Figura 1.17.29 

 

Figura 1.17.30 

  

  

� Explore os conceitos básicos sobre animação aqui apresentados até se familiarizar com a sua utilização. Pratique a 

criação e edição de curvas IPO e a utilização de restritores Follow Path.  

  

  



1 . 1 8  E x e r c í c i o  0 5 .  

Utilizando os conhecimentos que adquiriu até aqui crie animações iguais ou semelhantes às abaixo apresentadas. 

Deve utilizar obrigatoriamente os seguintes recursos: 

• Animação 1: Animação com recurso ao Game Engine. 

• Animação 2: Animação com recurso a KeyFrames com criação e edição de canais IPO LocX, LocY, LocZ, RotX, RotY, Rotz, 

ScaleX, ScaleY e ScaleZ. 

• Animação 3: Animação com recurso a restritores Follow Path. 

• Animação 4 (opcional): Animação com recurso a restritores Tack To. 

  

   

   

  

  

  



1 . 1 9  M o t o r  d e  J o g o .  

Como 1ª abordagem ao Motor de Jogo do Blender (Blender Game Engine (GE)), vamos ver como fazer um jogo 3D muito simples. 

Iremos progressivamente desenvolver jogos mais atractivos graficamente e mais complexos, quer na sua interface com o utilizador quer

na sua lógica interna. Os princípios básicos aqui introduzidos serão complementados em módulos posteriores, após a apresentação de 

técnicas de modulação avançadas, técnicas de construção de objectos articulados, técnicas de texturização e iluminação específicas para 

jogos e introdução à programação em Python. 

1.19.1 Game Engine - Locic Panel. 

O GE pode ser activado a partir e qualquer janela 3D. Note no entanto que o 

executável que poderá criar reflectirá sempre o ponto de vista da câmara 

activa. 

O GE pode ainda ser activado a partir do menu que surge ao seleccionar a 

opção Game da barra da Janela de Preferências, figura 1.19.1.  

O conjunto de acções a desencadear durante o jogo é definido nos painéis do 

ambiente Logic Panel. 

Para activar o GE coloque o rato sobre 

uma janela 3D e pressione a tecla [P]. 

Para sair do GE pressione [Esc].  

Para ter acesso ao conjunto de 

funcionalidades do GE seleccione 

(Logic) na barra da Janela de Botões, 

figura 1.19.2 , ou pressione [F4].
 

  

 

Figura 1.19.1 

 

Figura 1.19.2 

1.19.2 Blocos Lógicos - Sensores, Controladores e Actuadores.  

O Blender utiliza um sistema click-and-drag de Blocos Lógicos para definir a interacção entre si, e com o utilizador, dos objectos em 

cena. Veremos, em próximos módulos, como recorrer à linguagem de programação Python para desencadear acções cuja complexidade 

não esteja ao alcance dos blocos lógicos disponíveis. 

Há 3 tipo diferentes de blocos lógicos: Sensores; Controladores e Actuadores, figura 1.19.3. 

 

Figura 1.19.3 

Sensores.  

Os sensores são os blocos de entrada do sistema e destinam-se a detectar um 

qualquer sinal que aí seja presente, figura 1.19.4. O sinal de entrada poderá

ser de origem externa, por exemplo proveniente do teclado, do rato etc., ou de 

origem interna, por exemplo resultante de um acontecimento como a

proximidade ou colisão entre dois objectos etc., ou tão simplesmente um

impulso enviado aos controladores em cada uma das frames do jogo. Num 

próximo módulo faremos a sua descrição exaustiva.  

Controladores. 

Os controladores são os blocos intermédios do sistema. Recebem os sinais 

provenientes dos sensores, fazem o seu tratamento e enviam-nos para os 

  

  

 



controladores. Na sua forma mais simples poderão ser um simples AND ou OR,

ou uma qualquer expressão lógica combinatória de vários sinais que lhes 

sejam passados pelos sensores. Para tratar situações mais complexas, os

sinais dos sensores poderão ser utilizados num script escrito em Python. Figura 

1.19.5.  

Actuadores.  

Os actuadores são os blocos de saída do sistema. Recebem os sinais 

provenientes dos controladores e desencadeiam as acções desejadas enviando

sinais a sistemas externos ou internos, como sejam recomeçar o jogo, enviar 

uma mensagem a um qualquer objecto do jogo (cujos sensores receberão e 

consequentemente irá desencadear uma qualquer acção), modificar uma

qualquer propriedade interna, fazer mover um objecto, emitir um sinal sonoro,

iniciar uma animação, etc.  

Para criar um bloco lógico pressione o botão Add à direita de cada um dos

tipos. Se desejar eliminar um bloco criado pressione o botão X presente à 

esquerda, figura 1.19.7.  

Cadeia de Acção.  

Cada uma das acções a desencadear está associada a uma cadeia 

Sensor/Controlador/Actuador, figura 1.19.7. Após criar um bloco de cada

tipo pode estabelecer a sequência pressionando [LB ] sobre uma das 

pequenas "anilhas metálicas" e arrastando o rato, com o botão pressionado,

até à anilha adjacente, figura 1.19.7. Para eliminar uma ligação coloque o rato 

sobre o pequeno fio, que mudará a sua cor para branco, e pressione [X].  

Figura 1.19.4 

 

Figura 1.19.5 

 

Figura 1.19.6 

 

Figura 1.19.7 

Exemplo 1.  

• Abra o Blender. Seleccione o cubo padrão (aliás, ao abrir o Blender, o cubo encontra-se já seleccionado). 

 

• Pressione [F4] . Note que os blocos lógicos têm o nome do objecto seleccionado (pertencem ao objecto) .  

• Pressione [Add] em cada um dos tipos. Verá surgir um sensor Always, um controlador AND e um actuador Motion. 

• Pressione [LB ] sobre a anilha à direita do sensor e arraste o rato com o botão pressionado até à anilha à esquerda do 

controlador. Proceda de igual modo para as anilhas entre o controlador e o actuador.  

• No painel do actuador, pressione [LB ] sobre o campo imediatamente à direita de dLoc (correspondente a 

deslocamentos sobre o eixo dos xx) e escreva o valor 0.1. Neste momento deverá ter uma cadeia de acção idêntica à 

figura 1.19.7.  

• Seleccione a visão de câmara na janela 3D e, com o rato sobre a janela, pressione [P] para accionar o motor de jogo. 

Verá o cubo movimentar-se continuamente ao longo do eixo dos xx. Pressione [Esc] para sair do motor de jogo. 

O sensor Always envia ao controlador Motion um sinal em cada uma das frames do jogo. Tendo apenas uma entrada, o controlador AND 

transfere o sinal para a saída, activando o actuador em cada uma das frames. O actuador Motion, com dLoc=[0.1 0.0 0.0], altera, em 

cada frame, o valor da coordenada x da posição do centro do Cubo em 0.1 unidades Blender (BU). É assim criada a ilusão de movimento 

contínuo do cubo ao longo do eixo dos xx. 

Num próximo módulo explicar-se-á em detalhe cada um dos blocos lógicos disponíveis. 

1.19.3 Exemplo 2: "Plataformas" em 3D (versão 1).  

Vamos agora, através do exemplo de um jogo clássico de plataformas, ver alguns dos blocos lógicos disponíveis. Começemos por ver 

como movimentar um objecto recorrendo ao teclado.  



• Abra o Blender, elimine o 

cubo e, em TopView, insira 

um cone e um plano. 

• Coloque o cone na origem e 

rode-o de 90º sobre o eixo 

dos yy: xyz[0 0 0], RxRyRz[0 

90 0], figura 1.19.8. Note que 

os eixos coordenados locais e 

globais não têm agora 

correspondência directa. 

• Na barra da Janela 3D 

seleccione [Object>Clear/

Apply>Apply Scale/ 

Rotation to OBData], ou 

preesione [Ctrl]+[A]>[1],

figura 1.19.9, de modo a 

alinhar o sistema de eixos

locais com o sistema global, 

apagando qualquer registo de 

que o objecto tenha sido 

rodado (e escalado, se fosse o 

caso. 

Figura 1.19.8 

Figura 1.19.9 

No exemplo 1 o cubo move-se incessantemente devido ao facto do sensor

Always enviar ao controlador Motion um sinal por cada uma das frames. Vamos 

agora ver como controlar o movimento de um objecto em cena por recurso ao 

teclado. 

• Com o cone seleccionado, pressione [F4], pressione [Add] em 

cada um dos tipos de blocos lógicos e interligue-os, criando 

assim uma cadeia de acção. 

• No painel do sensor pressione os cursores à direita do tipo de 

sensor (por defeito Always quando cria um novo), para ter 

acesso à lista de sensores disponíveis, e seleccione Keyboard. O 

painel do sensor passa a ter a configuração da figura 1.19.10. 

Este novo tipo de sensor vai-nos permitir seleccionar uma tecla 

que será necessário pressionar para que o sensor envie um sinal 

ao controlador.  

• Seleccione a caixa Key e pressione [A]. A caixa em cima à 

direita é referente ao nome do sensor. Deve escrever um nome 

sugestivo que permita identificar o sensor facilmente nos casos 

em que a malha lógica se torne muito complexa. 

 

Figura 1.19.10 



• No painel actuador pressione [LB ] sobre o 3º campo à direita 

de Rot (correspondente a rotações em torno do eixo dos zz) e 

escreva o valor 0.1, figura 1.19.11. No botão L, imediatamente à 

direita, podemos especificar se a acção é referente ao sistema 

de eixos global (botão não pressionado), ou ao sistema de eixos 

local (botão pressionado (por defeito)). Dê um nome sugestivo 

ao actuador na caixa respectiva. 

 

Figura 1.19.11 

Seleccione a visão de câmara na janela 3D e, com o rato sobre a janela, pressione [P] para accionar o motor de jogo. Pressione [A]. Verá 

o cubo rodar sobre (o seu) eixo dos zz enquanto a tecla estiver pressionada e manter-se imóvel assim que deixar de pressionar a tecla. 

Pressione [Esc] para sair do motor de jogo. 

• Adicione 3 novas cadeias de acção e repita o procedimento para fazer rodar o cone à direita, agora com a tecla [D] e Rot

[0.0 0.0 -0.10]; fazer mover o cone em frente (eixo local xx), tecla [W] e Loc[0.1 0.0 0.0]; e fazer mover o cone para trás 

(eixo local -xx), tecla [S] e Loc[-0.1 0.0 0.0].  

A malha lógica deve agora ter a configuração que se mostra na figura 1.19.12. É conveniente, para uma melhor interpretação e

maneabilidade, simplificar o aspecto visual da malha. Pressione o triângulo invertido a amarelo do topo direito de cada um dos blocos 

lógicos, de modo a esconder a representação de cada um deles, figura 1.19.13. Pode esconder/mostrar todos em simultâneo

seleccionando a respectiva acção no menu disponibilizado ao seleccionar a caixa em cima à esquerda de cada um dos blocos lógicos.  

Pressione [P] para accionar o motor de jogo e movimente o cone livremente sobre o plano.

 

Figura 1.19.12 

Figura 1.19.13 

  



1.19.4 Leis da Mecânica.  

Em muitos jogos é importante que os intervenientes estejam sujeitos às leis da

física. Uma das características importantes do motor de jogo do Blender, 

designado por Bullet, é a simplicidade de integração das leis da mecânica

clássica no ambiente de jogo, que possibilitam a simulação de colisões, forças 

de atrito, resistência do ar, etc.  

• Seleccione o cone, pressione o botão Actor (topo esquerdo do 

Logic Panel), figura 1.19.3, e seguidamente o botão Dynamic, 

figura 1.19.14.  

Com estas duas simples acções, o cone passou a estar integrado num Mundo

sujeito às leis da mecânica, ficando sujeito à força da gravidade (com valor 

padrão 9.8, dirigida segundo o eixo global -zz (ver Worls Buttons, figura

1.19.15)) e sendo portador de uma massa (com valor padrão 1.0), figura

1.9.14. Verifique que no painel do actuador Motion apareceram novas opções:

Força, Torque (momento estático), Velocidade angular, etc. 

Exemplo 3: "Plataformas" em 3D (versão 2).  

Vamos agora ver como fazer saltar um objecto que esteja em contacto com 

uma superfície.  

Figura 1.19.14 

 

Figura 1.19.15 

 

Figura 1.19.16 

• Seleccione o cone e adicione uma nova cadeia de acção. Modifique o sensor para Keyboard e associe-lhe a tecla [Space]. 

No controlador Motion aplique uma força 50 segundo zz, Force[0.0 0.0 50]. Pressione o botão L para que a força fique 

referida ao sistema de eixos global.  

Pressione [P] para accionar o motor de jogo e pressione [Space]. Note que, em resultado da aplicação da força, o cone é impulsionado 

segundo o eixo dos zz sempre que se pressiona [Space], mesmo que não esteja assente sobre o plano. Para resolver este problema 

vamos recorrer a um sensor Touch.  

• Seleccione o cone, adicione um novo sensor e modifique o tipo para Touch. Ligue a saída deste sensor e o sensor da 

tecla espaço ao mesmo controlador AND, figura 1.19.17. Pressione [P] para accionar o motor de jogo. Verifique que agora 

o cone só é sensível à actuação da força quando está em contacto com o plano. 

Figura 1.19.17 

Vamos agora ver como fazer desaparecer objectos.  

• Introduza 3 cubos e duas esferas em cena, e dê-lhes um 

enquadramento idêntico ao da figura 1.19.18. 

• Seleccione uma das esferas. Pressione [F4>Actor>Ghost], 

figura 1.19.19.  

Um objecto imerso num Mundo sujeito às leis da física mas caracterizado como

Ghost não tem influência sobre a dinâmica desse Mundo, ou seja, comporta-se 

como um "fantasma". Qualquer objecto que entre no seu espaço não sofre

qualquer força. Vamos utilizar as esferas como objectos a coleccionar. O

objectivo será fazer o cone alcançar as esferas, resultando dai consequências a

nível da lógica do jogo mas não a nível do comportamento físico do cone.  

Figura 1.19.18 



• Com a esfera seleccionada, crie uma cadeia de acção. Escolha 

um sensor Near e um actuador Edit Object>End Object, 

figura 1.19.20. 

O sensor Near envia um sinal ao controlador sempre que um objecto (do tipo 

Actor) é detectado a uma certa distância (especificável no respectivo painel).  

 

Figura 1.19.19 

Por sua vez, o sinal do controlador é, neste caso, enviado ao próprio objecto que, por ter um actuador do tipo End Object, desaparece de 

cena.  

Figura 1.19.20 

Vamos ainda ver como associar um sinal sonoro ao desaparecimento de um 

objecto.  

• Crie um actuador do tipo Sound e ligue-o à saída do 

controlador AND em paralelo com o actuador End Object.  

• Pressione [F10], para ter acesso aos painéis do ambiente 

Scene, seguido de Sound Block Buttons, para ter acesso aos 

botões de controle de ficheiros áudio, e seleccione um ficheiro 

apropriado, figura 1.19.21. Uma vez seleccionado o ficheiro, 

encapsule-o no ficheiro Blender, para tornar o seu *.blend mais 

portável, pressionando o botão com o pequeno símbolo 

semelhante a uma "prenda", figura 1.19.23. 

• Pressione [F4] de novo e, no painel do actuador Sound, 

seleccione o ficheiro áudio que agora se encontra disponível, 

figura 1.19.22.  

Vamos também ver como enviar uma mensagem de um acontecimento 

(desaparecimento da esfera) a todos os objectos em cena (que fizerem parte 

da Lógica do Jogo).  

• Com a esfera seleccionada, crie um novo actuador, agora do 

tipo Message, e, no campo Subject, dê-lhe um nome 

sugestivo, figura 1.19.24.  

Figura 1.19.21 

 

Figura 1.19.22 

Figura 1.19.23 

• Ligue o actuador Message à saída do controlador AND, em paralelo com os actuadores End Object e Sound. A cadeia de 

acção da esfera está agora completa, como se mostra na figura 1.19.24. 



Figura 1.19.24 

• Crie uma cadeia de acção idêntica para a segunda esfera.

 

Nota: O modo mais prático de criar uma cadeia de acção idêntica para a 

segunda esfera é duplicar a primeira pressionando [Shift]+[D] e arrastando a 

esfera duplicada para a posição desejada ([Shift]+[D] acciona de imediato o 

Modo de Translação (G)). 

Finalmente vamos ver como coleccionar objectos e desencadear uma acção

quando a tarefa estiver concluída. 

• Seleccione o cubo mais à esquerda da cena, figura 1.19.18. 

Pressione [F4] e o botão Add Property, figura 1.19.25.  

A função desta propriedade será acumular o número de esferas eliminadas, ou 

seja, o número de vezes que este objecto (o cubo) recebe a Mensagem "Bola

Amarela". 

• Dê à propriedade um nome sugestivo, "ContadorBA", 

modifique o tipo de contador para Inteiro, e pressione o botão 

D, de "Debug", que permite ver o valor da propriedade enquanto 

o jogo se desenrola (para além disso, na barra da Janela de 

Preferências seleccione Show Debug Properties, figura 

1.19.26). 

• Crie uma cadeia de acção com um sensor Message e um 

actuador Property.  

 

Figura 1.19.25 

 

Figura 1.19.26 

• Na caixa Subject do sensor escreva o nome da mensagem enviada pelas esferas amarelas (para que não haja engano é 

preferível fazer [Ctrl]+[C]>[Ctrl]+[V] entre as duas caixas), figura 1.19.27.  

• Na caixa Prop do actuador Property escreva o nome do contador, figura 1.19.27.  

Figura 1.19.27 

Figura 1.19.28 

Vamos agora forçar a que, desde que as 2 esferas amarelas tenhas sido eliminadas, quando o cone se aproxima do 3º cubo o jogo acabe 

e seja emitido um sinal sonoro. 



• Com o 3º cubo seleccionado crie uma nova cadeia de acção, 

com um sensor Near e um sensor Property ligados em paralelo 

a um controlador AND, e ligue à saída deste um actuador Sound 

e um actuador Game, figura 1.19.28. 

• Na caixa Prop do sensor Property escreva o nome da 

propriedade que acumula o número de esferas amarelas 

eliminadas, seleccione o tipo Equal e faça Value igual a 2. 

• No actuador Game seleccione Quit this game. 

Pressione [P] para accionar o motor de jogo. Note a informação sobre a

propriedade do 3º cubo, ContadorBA, no canto superior esquerdo da janela do 

jogo.  

1.19.5 Criação de um Executável.  

O Blender permite criar uma versão executável stand-alone do jogo, isto é

uma versão que pode ser executada num qualquer ambiente (do mesmo

sistema operativo) independentemente do Blender estar instalado. 

Na barra da Janela de Preferências seleccione [File>Save Game As

Runtime] , figura 1.19.30, e salve o jogo na directoria que desejar. Abra a

directoria onde colocou o ficheiro *.exe e execute-o. Recerá uma mensagem

de erro assinalando a falta de um ficheiro *.dll (por exemplo zlib.dll, 

xvidcore.dll, etc.). Pode encontrar este ficheiros na directoria onde tem

instalado o Blender. Repita o procedimento, copiando todos os ficheiros *.dll

para a directoria onde tem o executável do jogo. 

 

Figura 1.19.29 

Figura 1.19.30 

� Explore os conceitos básicos sobre o Motor de Jogo do Blender aqui apresentados até se familiarizar com 

a sua utilização. Explore a utilização dos diversos sensores e actuadores criando novos cenários de jogo.  
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Utilizando os conhecimentos que adquiriu até aqui crie um jogo 2D e um jogo 3D na linha dos clássicos Plataformas, Bricks, PacMan,

SpaceInvaders, Tetris, etc. (ver exemplos (figuras 1.20.1 e 1.20.2)).  

Deve utilizar, no mínimo, os seguintes recursos: 

• Sensores: Keyboard; Touch; Near; Property; Message; Always.  

• Actuadores: Motion; Edit Object; Sound; Message; Game; Property; Constraint.  

  

 

Figura 1.20.1 

  

  

  

  

  

  

  

Figura 1.20.2  
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